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The electronically generated Job Jacket in Extensis Preflight Pro,
just as with the job jacket for a print job handled the mechanical
way, includes everything associated with a particular job: the doc-
uments included in the job, output instructions, job ticket informa-
tion, problem reports, special instructions, logs, and notes. In
addition, the electronic Job Jacket in Preflight Pro provides access
to all the information that can be gathered about the various job
elements (fonts, pictures, colors) by document and page, that must
be checked to ensure that the job will output properly.

The first tab in the Job Jacket, the “Files” tab, is the primary win-
dow within Extensis Preflight Pro. From the Files tab window you
have access to nearly all the operations and windows available in
the program. 

Working in the Job Jacket window

4—The Job Jacket

The Job Jacket window is the primary
w i ndow in Preflight Pro. Displays tabs for
all job elements that can be checked and
flagged, such as Pictures, Fonts, and
Colors. The first tab in this window, the
Files tab, includes the informative Files
List and the Preflight Pro operations
Button Bar.

A Job Jacket title bar and “Job Name”

B Files tab

C Pictures tab

D Fonts tab

E Colors tab

F Log tab

G Notes tab 

H Button Bar: Provides easy access to
major Preflight Pro operations. Refer
to the Job Jacket Files tab for details

I Files list: Displays all documents
included in the job and their status.
Refer to the Job Jacket Files tab for
details

J Help box: Informational window dis-
playing each button, column heading,
or icon function as the mouse passes
over it

K “Show only” check boxes: Used to indi-
cate which problem levels will be dis-
played. A ffects the Files List Status and
Page icons, and the problem Report.

B C
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H

The Job Jacket window

A

D
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Files tab

The Files tab in the Job Jacket is the primary window in Extensis
Preflight Pro. Here you will find the list of documents currently
included in the job, along with document status, pages included in
the problem report, total pages in the document, and the Profile
assigned to the document. You also have access to nearly all
Flight Pro operations through the button bar and the various icons
in the files list.

The Files tab window displays three areas of interest:

• Button Bar—The Button Bar gives you access to most of the
functions available in Preflight Pro, such as adding and remov-
ing documents from the Job Jacket; inspecting, opening, and
generating a problem report on documents; including and
excluding pages from a report; accessing the Job Ticket and
Output Specifications; and collecting the job.

• Files List—The Files List shows all the documents included in
the job, along with problem status, number of pages in the doc-
ument, which pages are included for problem checking, and
which Profile will be used for the problem report.  

• Show Only checkboxes—The Show Only checkboxes allow
you to filter the problem report by problem severity. In the
Profile you determine what problem flag (representing problem
severity) will be applied to each type of problem, then, using
the Show Only checkboxes, you determine which severity
group(s) you would like to have reported.
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Working in the Files tab

The Files window lists all documents in
the job, shows the overall status of each
document, indicates which pages are
included in the report and shows the
s t atus of each page, and lists the Profile
assigned to each document.

A Files tab in the Job Jacket

B The Button Bar 

C The Files List

D Help box: Button, column, or icon
function is displayed here when the
mouse passes over the item

E Problem severity checkboxes: These
determine what problem severities
will be included in the problem report.
After inspection, page icons on the
Files list reflect the overall status of
the page according the combined
setting of these flags and the current-
ly assigned Profile. E

The Job Jacket Files tab

A

B C D

To do this… Follow this procedure…

Go to the Files tab. Click the “Files” tab, or select “Files” from the Job menu, or press z1. 

Add document(s) to list. From the Finder, locate the document(s) you wish to add, then
drag them into the open Files tab window. Or click the “Add
Document” button, or select “Add Documents” from the Job menu.

Remove document(s) from list. Select the document(s) to be removed from the Files list, then
click the trash (Remove Documents) icon. Note: This action
removes the document reference from the list, it does not delete
the document from the disk.

Inspect a document. In the Files list, select the document(s) to be inspected. Click the
“Inspect” button. The documents will be scanned and processed. 
Completion time depends on document(s) size, processor
speed, image size, and other factors.

Open a document in the parent Select the document(s) on the Files list and click the “Open 
application. Document” button, or select “Open Document” from the Job menu.

Include pages in, or exclude pages Select the document, then click the “Include/Exclude Pages” 
from, the problem report. button. Or double-click in the “Selected” or “Total” column of the

desired document. In the dialog box, click the page(s) to be includ-
ed or excluded. A check mark beside the page number indicates 
that the page is “included.”
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Button Bar

The Button Bar provides access to many operations within
Preflight Pro. As you pass the mouse over each button, refer to the
Help box in the bottom left of the screen for a short description of
button function. Click the button to open up a dialog box or win-
dow to complete the desired operation.

The Button Bar inside the Job Jacket
Files tab provides access to many fea-
tures. Click a button to activate it.

A Extensis: Access information about
Extensis Preflight Pro 

B Add documents: Add documents to the
Files list

C Remove documents: Remove docu-
ments from the Files list

D Inspect: Inspect documents selected in
the Files list

E Output Instructions: Open the Output
Instructions for viewing or editing

F Include/Exclude pages: Include or
exclude pages from the report

G Report: Report on the documents
selected in the Files list

H Open: Open the documents selected
in the Files list in their parent
application

I Job Ticket: Open Job Ticket for view-
ing or editing

J Collect: Collect job elements 

The Job Jacket Button Bar

B CA E FD IG H J

Working with the Button Bar
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To do this… Follow this procedure…

Add documents to the job. Click the “Add Documents” button, then locate the documents to 
be added. Or drag documents into the open Files window,
or select “Add Documents” from the Job menu.

Remove documents from the Select the document(s) to be removed from the Files list, then
job. click the trash (Remove Documents) icon. Note: This action

removes the document reference from the list, it does not delete
the document from the disk. Or select the documents to be
removed, then select “Remove Documents” from the Job menu.

Inspect a document. In the Files list, select the document(s) to be inspected. Click the
“Inspect” button. The documents will be scanned and processed. 
Completion time depends on document(s) size, processor
speed, image size, and other factors. Or select the document(s)
to be inspected, then select “Inspect Selected” from the Job menu.

Edit or view the Job Ticket. Click the “Job Ticket” button. Or select “Job Ticket” from the
Job menu, or press zT.

Open a document in the parent Select the document(s) on the Files list and click the “Open 
application. Document” button. Or select the document(s), then select

“Open Document” from the Job menu.

Include pages in, or exclude pages Select the document, then click the “Include/Exclude Pages” 
from, the problem report. button. Or double-click in the “Selected” or “Total” column of the

desired document. In the dialog box, click the page(s) to be includ-
ed or excluded. A check mark beside the page number indicates 
that the page is “included.” Or select the document, then select
“Include/Exclude Pages” from the Job menu.

Edit or view the Output Instructions Click the “Output Instructions” button. Or select “Output
for a document. Instructions” from the Job menu.

Generate a report of the problems Select the documents you wish to include in the problem report. 
in the document(s) that might pre- Click the “Report” button. Or select “Report” from the Job menu, 
vent proper output. or enter zR.

Collect all job elements. Click the “Collect Job Elements” button. Or select “Collect Job
Elements” from the Job menu, or enter zK.

Determine the function of a button Pass the mouse over the item. The item function will be shown in 
or icon. the Help box at the bottom-left portion of the window.
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Files List

The Files List in the Job Jacket Files tab window lists all the doc-
uments in the job. This is the primary source for all actions per-
formed on job documents, as indicated below.

The Job Jacket Files List

The Files List in the Job Jacket shows all
the documents available for inspection.
The columns can be resized as needed:
place the cursor on the edge of a column
and drag the column to the desired size.

A Status: Indicates the status of the
document after inspection. Status
indicated will be the most severe case
found in the document. Options are:
OK, Error, Caution, Ignore, and Not
Inspected 

B Document: Shows the name of the
file. Full pathnames can be specified
in Edit: Preferences: General

C Pages: Shows all document pages.
White page icon indicates page has
been included in the report, slashed
page icon indicates excluded from
the report. Red page icon indicates
problem(s) found: generating a report
for this page is recommended.

D Selected: Shows page numbers
included for inspection

E Total: Indicates total number of pages
in the document

F Profile: Indicates the currently
assigned Profile for this document.
Column is also a pop-up menu for
assigning Profiles

Working with the Files List

G Double-click in the Status or Documents column of the selected document to
open the “Get Info” window for this document

H Double-click a Page icon for the selected document to open the “Get Info” window
for that page. N o t e : Help box shows page number as mouse moves over page icon.

I Double-click in the Selected or Total column for the selected document to open
the “Include/Exclude Pages” dialog for that document

J Click and hold down the mouse button to open the pop-up menu in the Profiles
column, then select a Profile for the selected document

B CA E FD
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To do this… Follow this procedure…

Display more detailed information Double-click in the Status or Documents column of the selected
about the document. document.

Display more detailed information Double-click the page icon for the desired page of the selected
about a particular page. document.

Include pages in, or exclude pages Double-click in the “Selected” or “Total” column of the desired doc-
from, the problem report. ument. Or select the document, then click the “Include/Exclude 

Pages” button. In the dialog box, click the page(s) to be included
or excluded. A check mark beside the page number indicates 
that the page is “included.”

Assign a new profile to the docu- Press and hold the mouse over the Profile column for the desired 
ment. document. Locate the desired Profile on the pop-down menu.

Release the mouse over a Profile to select it.
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Working with the Show Only checkboxes and Page icons

The “Show Only” checkboxes inside the
Job Jacket Files window allow you to
determine which problem severity
group(s), will be reported.

Only problems in the severity group(s)
indicated by the Show Only checkboxes
will be reported, as follows: 

A Error checkbox: Indicates that
problems flagged as error will be
r e p o r t e d

B Caution checkbox: Indicates that
problems flagged as caution will be
reported

C Ignore checkbox: Indicates that
problems flagged as ignore will be
r e p o r t e d

D Status icon: Indicates the status of
the document after inspection.
Status indicated will be the most
severe-case problem found in the
document. Options are:
Error, Caution, Ignore, and Not
Inspected

E White page icon: Indicates this page has no problems in the severity group(s) indi-
cated by the “Show only” condition flag checkboxes

F Red page icon: Indicates this page has at least one problem in at least one of the
severity groups indicated by the “Show only” condition flag checkboxes

G Slashed page icon: Indicates this page was excluded from the problem report 

The Job Jacket Show Only checkboxes and Page icons

B CA

D E F G

Double-clicking in the Status or Documents
column of the selected document, or
selecting a document in the Files list and
selecting “Get Info” from the File menu,
or selecting a document in the Files list
and entering zI, opens this window.

A Document Info window title bar 

B Document name and location

C Document data:

Created date and time, Modified date
and time, Creator name, Type, 
number of Pages, document Height
and Width

D List of Document Items (job elements):
Pictures, Fonts, and Colors

E Job elements listed by category
(Pictures, Fonts, Colors). Click arrow
to expand/condense list.

The Document Info window

B

C

D

E

A
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Pictures tab

The Pictures tab in the Job Jacket lists all the pictures in all
inspected documents in the Job Jacket and indicates—for each
occurrance of the picture—where it is used, the type of picture, its
status, and other information. Picture status will be displayed as
OK, missing, or modified.

Working in the Pictures tab

The Pictures tab in the Job Jacket  lists
the pictures required to output the job a n d
displays their status. Includes pictures
from all included pages of inspected docu-
ments in the Files list.

A Pictures tab in the Job Jacket

B Name: Shows picture name

C Used in: Lists where the picture is
used. Indicates if a picture was used
in another picture 

D Page: Lists the page number the
picture was found on

E Type: Indicates the picture file type,
such as TIFF, EPS, PICT, DCS, etc.

F Eff Res: Effective picture resolution

G Mode: Indicates the color mode of the
picture, such as RGB, CMYK, bitmap,
grayscale, etc.

H Status: Indicates the current status of
the picture as OK, missing, modified

I Creator: Indicates the parent appli-
cation (application that created the
p i c t u r e )

B C E F G

The Job Jacket Pictures tab

A
H ID
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Double-clicking a picture, or selecting a
picture then choosing “Get Info” from the
File menu or pressing zI, opens this
Picture Info window.

A Picture Info window title bar

B Information gathered about a picture:

File Name, File Location, Creation
Date, Modification Date, Picture
Creator, Document Used In,
Document Page, Picture Status,
Picture Type, Picture Color Mode,
Picture File Size, PicBox Origin
Across, PicBox Origin Down,
PicBox Height, PicBox Width, Picture
Width, Picture Height, Picture Scaled
Vertical %, Picture Scaled Horizontal %,
Physical Resolution, Effective
Resolution  (after scaling),
Background Color, Picture Color,
PicBox  Angle °, PicBox Skew °,
Picture Angle °, Picture Skew °,
Picture Flipped, Picture Styled,
Screen Transfer, Has Clipping Path,
Flatness of Path 

C Items used in the picture: Colors used,
Fonts used (in vector EPS files)

D Thumbnail preview of original file

B

C

The Picture Info window

A

D
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Fonts tab

The Fonts tab in the Job Ja cket lists eve ry font used in all the
inspected documents in the job wh i ch are needed to output those
d o c u m e n t s , and indicates their status. Status is determined by wh at
fonts are curre n t ly ava i l able to the system. Font status is updat e d
e a ch time the Fonts tab is selected; you may notice the font list
being cre ated on the screen as the status of each font is ch e cke d. 

Working in the Fonts tab

The Fonts lists fonts in the job and dis-
plays their status. Includes fonts from all
included pages of inspected documents in
the Job Files list.

A Fonts tab in the Job Jacket

B Screen Font: Indicates the name of
the font

C Style: Indicates the style applied to the
font, if selected from a style menu

D Printer Font: Indicates the required
printer font for the listed screen font

E Type: Lists font type as TrueType,
PostScript, Multiple Master, etc.

F System Status: Reports on system
availability of both screen and printer
fonts

G Foundry: Indicates the font manufac -
turer. Helps ensure that the output
facility owns the same font.

H Version: Indicates font version

B C E

The Job Jacket Fonts tab

A

G HFD

Double-clicking a font, or selecting a font
then choosing “Get Info” from the File
menu or pressing zI, opens this Font Info
window.

A Font Info window title bar

B Screen Font Name and Location

C Printer Font Name and Location

D Information gathered about this font:

Styles Applied, Font Type, Font
Status, Foundry, Font ID, Font Version

E Documents using this font         
Colors used with this font
Pictures using this font                

B

C

The Font Info window

A

D

E
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Colors tab

The Colors tab in the Job Jacket lists all the colors in all the
inspected documents in the job, indicates color name and type,
and shows a sample of the color. Colors listed may be used in pic-
tures and/or type. Both spot and process colors are listed.

C o l o rs listed as type “ P rinting Ink” a re either one of the pri m a ry col-
o rs (Cya n , M age n t a , Ye l l ow, B l a ck) or a Spot color. These are colors
t h at will ge n e rate a sep a rate plate when outputting sep a rat i o n s .

Working in the Colors tab

The Colors tab in the Job Jacket lists the
colors in the job and displays their type.
Includes colors from all included pages of
inspected documents in the Job Jacket
Files list.

A Colors tab in the Job Jacket

B Color Sample: Shows an example of
what the color looks like

C Name: Lists color name

D Type: Indicates color type, such as
Printing Ink (Spot), Process

E CMYK: Lists the QuarkXPress CMYK
values for the color 

F Screen Angle: Indicates the screen
angle that the color will be output as

B C

E

F
A

Double-clicking a color, or selecting a
color and choosing “Get Info” from the File
menu opens this Color Info window.

A Color Info window title bar

B Color sample

C Information gathered about the color:

Color Name, Color Type (Process or
Printing Ink), Screen Angle, CMYK
values, RGB values, Hue °,
Saturation %, Brightness %

D Documents where color is used
Pictures where color is used
Fonts where color is used

B

C

The Color Info window

A

D

The Job Jacket Colors tab

D
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Log tab

The Job Jacket Log lists some types of events that have occurred
with the job since the Job Jacket was created. Events logged
include the date and time documents were added, inspected, or
deleted. Unlike information in the Notes tab window, information
in the Log cannot be edited.

Working in the Log tab

The Log tab inside the Job Jacket lists
everything that has happened to the job
since the Job Jacket was created.

A Log tab in the Job Jacket

B Date: Indicates the date when a docu-
ment was added to the Files list, date
when inspected, or date when deleted
from the Files list

C Time: Indicates the time when a doc-
ument was added to the Files list,
time when inspected, or time when
deleted from the Files list

D Log: Indicates what action was taken
and gives the name of the document
the action was taken on

B C

The Job Jacket Log tab

A

D
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Notes tab

The Notes window provides a simple yet effective way to add
notes to the Job Jacket. Think of these Notes as sticky-notes for
the Job Jacket—a place to jot down information that can’t be
added anywhere else.

To create a Note:

1. Go to the Job Jacket Notes window by clicking the “Notes”
tab, then click “New Entry.”

2. Enter your name and the text of your note.

3. Click “OK.”

Working in the Notes tab

The Notes tab is a simple communication
tool for adding information to the Job
Jacket. 

A Notes tab in the Job Jacket

B New Entry: Click to create a new note

C Edit Entry: Click to edit the selected note

D Delete Entry: Click to delete the
selected note

E Date: Indicates the date the note was
created or modified

F Time: Indicates the time the note was
created or modified

G Name: Indicates the name of the per-
son who created or edited the note

H Notes: The text field for the note

I Double-click the selected note to open
the Edit Entry window

C

The Job Jacket Notes tab

A

D

GF H

Double-clicking a note, or clicking the
New Entry or Edit Entry button in the
Notes tab of the Job Jacket opens this
w i n d o w.

A New Note window title bar

B Cancel: Click here to leave the note
unchanged

C OK: Click here to indicate you are fin-
ished editing the note

D Name: Enter the name of the person
creating or editing the note here

E Notes: Enter the text of the note here

The New Note window

A

D
E

E

B

B C
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Specifying document Output Instructions

Each document in your print job will include specific output
instructions, such as trim size, inks, and line screen. This output
information must be entered into the job file so that Preflight Pro
can check it against the document. Information entered here is
used to calculate the number of printing inks used, find possible
resolution problems, and determine if the final trim size matches
the page size indicated in the document.

Working in the Output Instructions dialog

The Output Instructions dialog allows you
to indicate how each document in the job
should be output. These values will be
checked against the values specified in
the document.

A Output Instructions title bar

B Printing Inks: Indicate CMYK and
Spot colors here

C Line Screen: Indicate Screen in Lines
per Inch here

D Trim Size: Indicate page Trim height
and width. Displays in inches. Enter
values in points, picas, mm, or cm.

E Cancel: Click here to close the Output
Instructions window without making
changes

F OK: Click here to save changes and
close the Output Instructions window

C

The Output Instructions dialog

A

D

E

B

F

Printing Inks The total number of inks used in the document, to ensure that 
extra plates are not output.

Line Screen The resolution of each picture in the document. Preflight Pro 
determines whether resolution problems exist by using this setting
along with the resolution settings in the Profile assigned to the 
document. 

Trim Size The Page Size specified in the document. Note: Displays in
inches. Values entered in points, picas, mm, cm must include the
measurement name. Values other than inches will be converted 
and displayed in inches when the dialog box is reopened. 

When you specify… Preflight Pro compares your specification to…
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To specify Output Instructions:

1. Go to the Job Jacket Files window by clicking the “Files”
tab, or press z1, then select the document for which you
wish to specify output instructions.

Note: You can apply the same output instructions to more than
one document. To do so, select all the documents requiring the
same output instructions from the Job Files list before you
open the Output Instructions window. The Output Instructions
dialog box will change, allowing you to indicate which specifi-
cations to apply to the selected documents. 

2. Click the Output Instructions button, or select “Output
Instructions” from the Job menu.

3. Enter your instructions.

4. Click “OK.”

N o t e : C h a n ging the settings in the Output Instructions does not
ch a n ge settings in the Quark X P ress document.

Default Output Instru c t i o n s

You can specify a Default Output Instruction that includes yo u r
s t a n d a rd output info rm ation and is automat i c a l ly applied to new
documents added to the Job Files list. You can then ch a n ge the
i n s t ructions on those jobs that re q u i re it. To ch a n ge the defa u l t
Output Instru c t i o n s , select “ P re fe re n c e s : D e fault Output
I n s t ru c t i o n s ” f rom the Edit menu.

Output Instructions
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Inspecting Documents

Inspecting a document causes Preflight Pro to gather all the infor-
mation from the document to determine what might prevent it
from outputting properly. Before a document can be inspected, it
must be added to the Job Jacket. Once in the Job Jacket, docu-
ments can be inspected individually, all at once, or in any combi-
nation.

Using the various tabs inside the Job Jacket window you can
examine information that was gathered during the inspection
regarding document parameters, fonts, pictures, and colors. 

Inspecting a document is the fi rst step in determining possibl e
p ro blems. Info rm ation gat h e red during the inspection is added to
the dat abase of info rm ation in the job fi l e. Without the inspec-
t i o n , no info rm ation about the document is ava i l able for pro bl e m
t e s t i n g. 

After the inspection, when a new Profile is assigned, Preflight Pro
examines the data gathered during the inspection, checks it
against the problem conditions specified in the Profile and Output
Instructions, determines whether problems exist, and displays an
overall summary of the results using the icons in the Status and
Page columns of the Job Jacket Files List.

If problems are reported by the icons, you can generate a detailed
Report. The Report lists each and every problem found (according
to the settings in the assigned Profile and the problem condition
flag checkboxes). You can limit your Report to just the offending
pages, if you wish, by using the Include/Exclude Pages feature.
Refer to chapter 6, “Problem Reporting and Checking” for more
information on problem reports.

When the problems have been identified and corrected, the docu-
ment can be reinspected to verify that all the problems have been
corrected.



55

To inspect a document:

1. Go to the Job Jacket Files window by clicking the “Files”
tab, or press z1, then select the document(s) you wish to
inspect.

If the documents you wish to inspect do not appear on the
document list in the Files tab window, locate and drag them
into this window. Or click the “Add Documents” button and
locate the document in the files list, or select “Add
Documents” from the Job menu.

Note: In the Files List, use the SHIFT key to select multiple
documents contiguously; use the z key to select multiple doc-
uments non-contiguously; use zA to select all documents.

2. Click the “Inspect” button, or select “Inspect Selected”
from the Job menu.

Preflight Pro will launch QuarkXPress, then open the speci-
fied document(s) and gather all the information necessary for
preflighting. Preflight Pro keeps you posted on it’s progress
with a progress bar. When the inspection is complete, Preflight
Pro will close the document(s), if they were closed prior to
inspection.

N o t e : If a document was open prior to inspection by Pre fl i g h t
P ro , P re flight Pro will leave it open after inspection.

N o t e : You can instruct Pre flight Pro to leave all document(s)
open when the inspection is complete. Refer to “ S e t t i n g
P re fe re n c e s .”

Inspect
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Including and Excluding pages

Extensis Preflight Pro allows you to quickly and easily exclude
document pages from, or include document pages in, the problem
report. You might, for example, be having problems with a partic-
ular page and wish to see a problem report on just this page as
you work on correcting it. 

Or you might want to ap p ly a diffe rent pro file to certain pages of a
document. For ex a m p l e, you might be printing diffe rent pages of a
single document on diffe rent pre s s e s , p e r h aps because the fo u r-
color cover has been included in the same document as the one-
color inside pages. In this case you would use the Incl u d e / E x cl u d e
fe at u re along with the Duplicate Document fe at u re to ap p ly diffe r-
ent pro blem pro files and output instructions to selected page s .

To Include or Exclude pages from a report:

1. Go to the Job Jacket Files window by clicking the “Files”
tab, or press z1, then select the document for which you
wish to change page selections.

2. C l i ck the “ I n cl u d e / E x clude page s ” bu t t o n , or doubl e - cl i ck in
the “ S e l e c t e d ” or “ To t a l ” column for the selected document.

This will bring up the Include/Exclude pages dialog.

3. In the Include/Exclude dialog, click beside the desired
page(s) to toggle the checkmark(s) off or on. 

A checkmark next to the page indicates the page will be
included in the report. No checkmark indicates the page will
be excluded from the report.

Click “None” to exclude all pages from the problem report, or
click “All” to include all pages in the report.

4. The page icons for all excluded pages (on the Job Jacket
Files list ) will be shown with a slash through them, wh i l e
p age icons for included pages are either white (indicating no
problem) or red (indicating problem(s) found). 

N o t e : When a page is “ ex cl u d e d,” all info rm ation associat e d
with that page and any job elements on it (unless they are used
e l s ewh e re on an included page) are re m oved from both the info r-
m ational and pro blem rep o rting windows. This includes the
R ep o rt window, rep o rts printed after the ex clusion is indicat e d,
and the va rious job element windows such as the Picture s , Fo n t s ,
and Colors tabs in the Job Ja cket. The info rm ation remains in
the job file dat abase howeve r, and is instantly ava i l able by
ch a n ging the page designation from “ ex cl u d e ” to “ i n cl u d e.”

Include/Exclude Pages

Excluded
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Duplicating documents

Preflight Pro’s “Duplicate Document” feature is a very powerful
option that allows you to test different output scenarios for a doc-
ument by applying different Profiles and/or Output Instructions
and then checking for problems. This might be useful when you
need to output a document to both a medium resolution color
laser printer and a high resolution imagesetter. Using the
Duplicate Document feature you can generate a single report that
includes both output scenarios.

And used in conjunction with Preflight Pro’s “Include/Exclude
pages” feature, duplicating a document allows you to apply a dif-
ferent set of problem parameters for different pages of a docu-
ment. For example, a document might contain a 4-color cover
along with 1-color inside pages, requiring different Output
Instructions and posing a completely different set of potential
problems. To simplify your work, you can duplicate the document
and use different Profiles to check for problems. 

To Duplicate a document:

1. Go to the Job Jacket Files window by clicking the “Files”
tab, or press z1.

2. Select the document(s) to be duplicated.

3. Select “Duplicate Document” from the Job menu, or press
zD.

The original document will have “:1” appended to the file-
name, while the duplicated document will have “:2” appended
to the filename.
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Adding and Removing documents

Documents can easily be added to or removed from the Job Jacket
Files List as the job changes. Note that when a document is added
to the Files List, it is automatically assigned the specified Default
Profile and the specified Default Output Instructions.

Note: Adding Documents to and Removing Documents from the
Job Jacket does not add files to or remove files from the disk.
Preflight Pro merely adds the name of the document to its list of
documents in the job, and uses a pointer to determine where these
documents are located.

To Add a document to the Job Jacket:

1. Go to the Job Jacket Files tab window by clicking the
“Files” tab, or press z1.

2. From the Finder, locate the document(s) you wish to add to
the job, then drag them into the open Files tab window.

— or —

2. Click the “Add documents” button in the button bar or
select “Add Documents” from the Job menu. 

3. Locate the document(s) you wish to add, then click “Add.”

This will add the document(s) to the “Choose documents to
add” list. If you have more documents to add to the job, use
the file/folder hierarchy to locate them, then select and “Add”
them to the document list. Newly added documents are auto-
matically assigned the Default Profile and Default Output
Instructions.To add all the documents in a folder at the same
time, click “Add All.”

4. When all documents to be added to the job are displayed
in the “Choose document to add” list, click “Done.”

Add Documents
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To Remove a document from the Job Jacket:

1. From the Job Jacket Files List, select the document(s) to
be removed.

2. C l i ck the “ R e m ove selected documents” button in the bu t-
ton bar, or select “ R e m ove Documents” f rom the Job menu. 

You will be presented with a dialog box that asks “Are you
sure you want to remove the selected documents?”

3. Click “Remove” to remove the selected documents from
the job. Click “Cancel” if you do not wish to remove the
documents.

N o t e : R e m oving a document from the Files List also re m ove s
f rom the job file dat abase all info rm ation about the document
t h at was gat h e red during the inspection and rep o rting pro c e s s e s .

Opening documents

With Preflight Pro’s “Open Document” command you can open
any document or file in the Job Jacket Files List without leaving
Preflight Pro. And the document doesn’t have to be a
QuarkXPress document—any document can be added to the job
jacket regardless of which program created it.  

Notes: The application that created the document must be avail-
able to the Macintosh System before you can open it. And while
you can open a document created in another application, at this
time, only QuarkXPress documents can be inspected and checked
for possible output problems using Preflight Pro.

To Open a document from Preflight Pro:

Note: The document will be opened in the parent application.

1. Go to the Job Jacket Files tab window by clicking the
“Files” tab, or press z1.

2. Select the document you wish to open.

3. Click the Open Document button, or select “Open
Document” from the Job menu. 

Open Document

Remove Selected Documents
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Exporting job information

Preflight Pro gives you the opportunity to export data collected by
the inspection into a text file that can be imported into another
application according to your needs.

Note that the exported text file is not the same as a printed prob-
lem report. Printed reports display problems found and other job
element information, whereas the export file is a text file intended
for users who wish to import job information into a custom data-
base for their own purposes.

To Export Job Information:

1. Select “Export Job Info” from the File menu.

2. Choose a name for the Job Info file, then choose location to
store it.

3. Click “Save.” This will export the job information to the
named text file in the location indicated in step 2.
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Relinking Documents

Preflight Pro keeps track of files by name and location. If a docu-
ment is renamed or moved while the job file is closed, it will be
listed as “Missing” when the job file is reopened. The document
status will be changed temporarily to Unknown, as indicated by
the blue question mark icon.

To Relink a document:

1. Select a document indicated as “Missing” from the Job
Jacket Files List.

2. Select “Relink Documents” from the Job menu.

You will be asked to locate the missing document.

3. Locate the document, then click “Open.”
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Setting Preferences

Using the Preferences settings in the Edit menu, you can specify
some default parameters for Preflight Pro such as the copy of
QuarkXPress to launch, configuring a Default Job Ticket and set-
ting the Default Output Instructions.

General preferences

From the General Preferences you can decide:

• Whether or not Preflight Pro will automatically inspect docu-
ments when they are added to the Job Jacket.

• Whether or not Preflight Pro will leave the documents open in
QuarkXPress after inspecting them.

• Whether or not Pre flight Pro will show the full pathname fo r
documents in the Documents column of the Job Ja cket Files List.

• Whether or not Preflight Pro will check for problems only when
a report is generated, or if it will also check for problems each
time that: a Profile is created or assigned or the Output
Instructions are changed.

• Which copy of QuarkXPress (if applicable) will be used to
open documents for inspection and when using the Pilot to “go
to” and correct problems.

To change the General preferences:

1. Select Preferences: General from the Edit menu.

2. Indicate your desired options.

To specify which copy of QuarkXPress to use, click “Specify,”
then locate the appropriate QuarkXPress application. 

3. Click “OK” to save the selected options.
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Default Ticket

Information entered into the Default Job Ticket will automatically
be applied to all new jobs after the Default Ticket has been
changed.

Use the Default Ticket to enter job information that is consistent
from job to job to save data entry time, then change the Job Ticket
information as needed for each document. 

If no information is entered into the Default Job Ticket, the Job
Ticket for all documents will initially be blank.

To create or change the Default job Ticket:

1. Select Preferences: Default Ticket from the Edit menu.

2. Enter the desired information.

Click through the tabs one at a time and enter the appropriate
information in each tab window. This information will be
assigned to each new document added to the Job Jacket Files
List, and to documents in all future jobs as they are created.

3. Click “OK” to save Default Ticket information.
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Default Output Instructions
Information entered into the Default Output Instructions dialog
will automatically be applied to all documents added to existing
jobs after the Default Output Instructions have been changed.

You might want to enter job information that is consistent from
job to job to save data entry time, then change the Output instruc-
tions specifications as needed for each document. 

To change the Default Output Instructions:

1. Select Preferences: Default Output Instructions from the
Edit menu.

2. Enter default output instruction information.

Enter the appropriate information by section: Printing Inks,
Line Screen, Trim Size. This information will be assigned to
each new document added to the Job Jacket Files List, and to
documents in all future jobs as they are created.

3 . C l i ck “ O K ” to save Default Output Instruction info rm ation.
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